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This readme contains information for both iDRAC7 and LC2-RS. 
 
iDRAC7 is a systems management hardware and software solution that provides remote management capabilities, crashed 
system recovery, and power control functions for Dell PowerEdge systems. 
 
LC2-RS provides advanced embedded systems management and is delivered as part of iDRAC7. LC2-RS enables remote 
systems management in a one-to-many method.  Remote Services uses WS-Management (WS-MAN) protocol based Web 
services interface to remotely provision and manage the servers. 
 

What’s New 
 
The following are the new features in this release: 
 

• Update device firmware for all devices supported by Lifecycle Controller. 
• View staged and manage firmware updates. 
• Backup and restore the server profile. 
• Export hardware inventory. 
• View hardware and firmware inventory information for additional components.  
• Virtual Console 

o Automatically lock the operating system. 
o Scale the Virtual Console Viewer. 
o Use keyboard macros. 
o Set the first boot device using Virtual Console Viewer. 

• Enable iDRAC to automatically use the dedicated NIC if the link is available     on the dedicated NIC port. 
• View the currently active NIC. 
• Enable Virtual Console indication on the front panel LCD. 
• Set Lifecycle Controller or BIOS Boot Manager as the first boot device. 
• Set Time zone and Network Time Protocol (NTP). 
• Enable OS to iDRAC Pass-through. 
• Improved security features such as: 

o Change the default password for the user who logs in to iDRAC7 using the default credentials: root and 
calvin 

o Generate and use Custom Signing SSL signing certificate 
• View CPU details such as processor automatic throttling and predictive failure information. 
• View health and state information for Dual In-line Memory Modules (DIMMs) 
• Monitor the health and view inventory for Fibre Channel Host Bus Adapter (FC HBA) devices. 
• Enable SNMP v3 protocol as the user authentication mechanism. 
• Support for SNMP Traps on V1 and V2. Support for SNMP Gets on V1, V2, and V3 or only in V3 format. 
• Send alerts remotely to an external server. 
• Receive WS event notifications. 
• Reset iDRAC7 to factory defaults using the Diagnostics Console. 
• For RACADM commands, type starting letter and press TAB key to complete the command and use cd to traverse 

between various levels. 
• Support for Safari, Chrome, and Mac OS X. 
• Perform server configuration using the export/import XML profile feature through RACADM and WS-MAN. 

 
Note: The features are available depending on the iDRAC7 license installed in the system.  
 
For more information about these features, see the iDRAC7 User's Guide. 

 



 

Hardware and Software Requirements 
License Requirements 

• Software licensing has replaced hardware licensing. For more information, see, the Dell License Manager User's 
Guide.  

• Lifecycle Controller features such as Auto Discovery and vFlash are now licensed. You must install the correct 
licenses for Lifecycle Controller Remote Services to work properly. 

Supported Systems 
iDRAC7 and LC2-RS is supported on the following Dell PowerEdge systems: 

• PowerEdge T320        
• PowerEdge R320        
• PowerEdge T420      
• PowerEdge R420     
• PowerEdge M420       
• PowerEdge R520     
• PowerEdge M520     
• PowerEdge T620         
• PowerEdge R620     
• PowerEdge M620     
• PowerEdge R720     
• PowerEdge R720xd    
• PowerEdge R820      
• PowerEdge M820     
• DCS2210            
• Compellent SC8000 

Supported Managed Server Operating Systems for iDRAC7 
The following operating systems support iDRAC7: 

• Windows 8 (x64 only) 
• Windows Server 2008 R2 (x64 with Hyper-V) 
• Windows Server 2008 R2 SP1 (x64 with Hyper-V) 
• Windows Server 2008 SP2 (x86 and x64) 
• Windows Small Business Server 2011 (x64) 
• SUSE Linux Enterprise Server (SLES) version 10 SP4 x86_64 
• SUSE Linux Enterprise Server (SLES) version 11 SP2 x86_64  
• Red Hat Enterprise Linux (RHEL) version 5.8  
• Red Hat Enterprise Linux (RHEL) version 6.3 
• Red Hat Enterprise Virtualization (RHEV) version 3.0  
• ESXi version 5.0 U1  
• ESXi version 5.1  



• ESX/ESXi version 4.1 U3  
• Mac OS X 10.7 (Lion) 

Supported Management Station Operating Systems and Web Browsers for 
iDRAC7 

• Microsoft Internet Explorer 8 on Windows 2003 SP2 
• Microsoft Internet Explorer 9 on Windows Server 2008, Windows Server 2008 (x64), and Windows Server 

2008 R2 (x64) 
• Microsoft Internet Explorer 10 on Windows 7 (x86 and x64), Windows Server 2012 also known as Windows 8 

(x86 and x64), Windows Server 2008 (x86 and x64), and Windows Server 2008 R2 (x64)   
• Mozilla Firefox 15 and 16 on Windows 7 (x86 and x64), Windows Server 2012 also known as Windows 8 (x86 

and x64), Mac OS X Lion (10.7), Windows 2003 SP2, Windows Server 2008, Windows Server 2008 (x86 and 
x64), and Windows Server 2008 R2 (x64) 

• Google Chrome on Windows Server 2012 also known as Windows 8 (x86 and x64)  
• Safari 5.2 on Mac OS X Lion (10.7) 
• Native Mozilla Firefox on SLES 10 SP4, SLES 11 SP2, RHEL 5.8 (x86 and x64), RHEL 5.9 (x86 and x64), RHEL 6.2, 

RHEL 6.3, and RHEL 6.4 

Installation 
iDRAC7 - Installation 

Prerequisites 
Before you update iDRAC7 firmware using local RACADM or the Dell Update Package, perform the following procedures. 
Otherwise, the firmware update operation may fail. 

1. Install and enable the appropriate IPMI and managed node drivers.  
2. If your system is running a Windows operating system, enable and start the Windows Management Instrumentation 

(WMI) service. 
3. If you are using iDRAC7 Enterprise and your system is running SUSE Linux Enterprise Server (version 10) for Intel 

EM64T, start the Raw service. 
4. Disconnect and unmount Virtual Media. 
5. If iDRAC7 firmware update is interrupted for any reason, you must wait for at least 30 minutes before you start the 

firmware update again. 

Installation and Configuration Notes 
• From the Windows host operating system (managed node), run the Dell Update Package for Windows and follow 

the instructions on the update wizard. 
• From the Linux host operating system (managed node), run the Dell Update Package for Linux from the shell 

prompt. Follow the instructions displayed on the console. 
• From the management station, remotely update the firmware using the iDRAC7 Web interface: 

1. Extract the firmware image self-extracting file to the management station. 
2. Open the iDRAC7 Web interface using a supported Web browser. 
3. Log in as administrator. 
4. Go to Overview -> iDRAC Settings -> Update and Rollback -> Update. The Firmware Update page is 

displayed.  



 

5. Click Browse, select the .d7 firmware image file that you extracted (step 1),  or the Dell Update Package 
(DUP) for Windows, and click Upload. 

6. Wait for the upload to complete. After the upload is completed, the Update Details section displays the 
firmware file uploaded to iDRAC and the status. 

7. Select the firmware file and click Install or Install and Reboot. If it is a DUP, Install dynamically changes to 
Install and Reboot and at the same time the Install Next Reboot is activated. When you click Install and 
Reboot or Install Next Reboot, the message “Updating Job Queue” is displayed. 

8.  Click OK. The Job Queue page is displayed, where you can view and manage the firmware update. After the 
update is completed, iDRAC7 restarts automatically. For more information, see the iDRAC7 User's Guide 
available at support.dell.com/manuals. 

Upgrade 
iDRAC7 firmware cannot be installed on platforms that support iDRAC6 and cannot be used to upgrade iDRAC6 firmware to 
iDRAC7. For more information, see the iDRAC7 User's Guide available at support.dell.com/manuals. 

Uninstallation 
Use the rollback feature to return to the previous installed version of iDRAC7 firmware. For more information, see the 
iDRAC7 User's Guide available at support.dell.com/manuals. 

Lifecycle Controller 2 Remote Services - 
Client Tools 
Use the WinRM and OpenWSMAN CLI client tools to send WS-MAN commands to Lifecycle Controller. 

WinRM 

WinRM is a Windows native WS-MAN client. 

It is recommended to use WinRM 2.0 on Windows Management Stations. WinRM 2.0 is installed by default as a part of 
Windows 7 and Windows Server 2008 R2. It can also be installed as a part of the Windows Management Framework Core 
package on the following systems: 

• Windows Server 2008 SP1 

• Windows Server 2008 SP2 

• Windows Server 2003 SP2 

• Windows Vista SP1 

• Windows Vista SP2 

• Windows XP SP3 

For more information on how to install WinRM 2.0 as a part of the Windows Management Framework Core package, see 
article 968929 in the Microsoft Knowledge Base at: 

http://go.microsoft.com/fwlink/?LinkId=186253 

Recommended WinRM Client Configuration: 

http://go.microsoft.com/fwlink/?LinkId=186253


• MaxBatchItems = 50 

• MaxTimeoutms = 60000 

• MaxEnvelopeSizekb = 150 

• NetworkDelayms = 60000 

Sample WinRM Command (Enumeration Operation): 

winrm e cimv2/DCIM_SystemView?__cimnamespace=root/dcim -u:[idrac user]  

-p:[idrac password] -r:https://[idrac ip adddress]/wsman -encoding:utf-8  

-a:basic -SkipCNcheck -SkipCAcheck -format:Pretty 

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed certificates are not 
accepted by the WinRM client and WinRM commands do not work without these options:  

-SkipCNcheck and –SkipCAcheck 

OpenWSMAN CLI 
OpenWSMAN CLI is an open source Linux WS-MAN client. OpenWSMAN CLI source code and installation details are available 
at: 

http://sourceforge.net/projects/openwsman/files/wsmancli 

Sample OpenWSMAN CLI Command (Enumeration Operation): 

wsman enumerate http://schemas.dmtf.org/wbem/wscim/1/cim-schema/2/DCIM_SystemView  

-h (idrac ip adddress) -P 443 -u (idrac user) -p (idrac password) -v -j utf-8  

-y basic -R -o -m 256 -N root/dcim -c cert_name.cer –V 

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed certificates are not 
accepted by the OpenWSMAN CLI client and WS-MAN commands do not work without these options: -c, -v, and –V  

See the OpenWSMAN CLI Readme for details on these options. 

iDRAC7 - Notes 
• Only if there are one or more network interface cards (NDC or LOM) present on the managed system, Network 

Devices appears under Overview > Hardware in the iDRAC7 Web interface. 

• When using iDRAC7 Web interface in Firefox 3.6 if the SD card is removed while partition creation is in-progress, 
the operation has been completed successfully message is displayed. 

• If Virtual Console and Virtual Media are configured to use Java plug-in, then you must disable Enhanced 
Security Mode in Internet Explorer. If this is not possible, then in iDRAC7, configure Virtual Console to use 
ActiveX plug-in.  You must enable ActiveX control in IE, add the iDRAC7 Web URL to the Intranet security zone, 
and set the security level for this zone as Medium-Low for Virtual Console and Virtual Media to function properly. 

• If the instant messenger is launched in the Virtual Console viewer with ActiveX native plug-in and another 
application is started (example Notepad, WordPad, and so on) without minimizing the Virtual Console, the instant 
messenger box also pops-up on other applications. This does not happen with Java plug-in. 

http://sourceforge.net/projects/openwsman/files/wsmancli


 

• When a system is in POST, it is not possible to attach a vFlash partition as the First Boot Device. 

• Virtual Console Viewer from iDRAC7 Web interface terminates when the managed system is restarted. 

• If common logging is enabled in iDRAC7, CEM storage inventory takes more than 40 minutes. If common logging is 
disabled (default setting), CEM storage inventory takes up to four minutes for the maximum configuration. 

• A pop-up message is not displayed to confirm if test emails are successfully sent or not. 

• For iDRAC7 Enterprise, when the Virtual Console is disabled and Virtual Media is disabled and/or detached, the 
console port (default: 5900) remains open.  For iDRAC7 Express (no Virtual Console or Virtual Media) the console 
port is open. 

• If auto-negotiation is enabled while setting iDRAC7 network, 1 Gbps is not supported and you cannot manually 
select it. 

• A USB device mounted through Virtual Media in floppy emulation mode for a Linux operating system shows as a 
removable volume. 

• During system power operations, if the video mode changes, the message Out of range may appear for a short 
while on the Virtual Console. 

• When using the Virtual Console in native console mode with Pass all keystrokes to server disabled in 
Internet Explorer versions 8 and 9, if an F1/F2 prompt is encountered, pressing F1 displays the Virtual Console 
online help pop-up in addition to continuing with the system boot. 

• When any of the storage enclosure components are removed, the corresponding details are not displayed. Only the 
name and status attributes are displayed. 

• When certain RAID operations are requested using WS-MAN on non-RAID cards such as, the Dell SAS 6Gbs HBA or 
the Internal Tape Adapter, the operation succeeds, however the job fails with the error message Unable to 
locate device in current configuration. 

• If the iDRAC7 network is configured to use a shared LOM and the spanning tree is enabled on the LOM port, WS-
MAN and remote service commands may time-out in the following scenarios: 

o At system reboot 

o When CSIOR is running 

o While entering SSM 

The connectivity lost is variable. In typical cases, it is approximately: 

o 40 seconds at system reboot and varies per NIC or link speed 

o 20 seconds when CSIOR is running 

o 40-60 seconds while entering SSM 

The reason is that when spanning tree is enabled, the switch does not allow the link to re-establish the connection 
after a reset until it completes checking for network loops. Server reboots reset the NIC and disconnects the link. 

Note: This does not occur while using dedicated NIC because server reboots do not affect the dedicated NIC. 

• When logging in to iDRAC7 Web Interface using Internet Explorer 9 and IPV6 address, the connection may not 
succeed. To resolve this, make sure that in Internet Explorer > Tools > Internet Options > Connections > LAN 
Settings, the Use automatic configuration script option is cleared. 



• On PowerEdge systems with cabled power supply units installed (that is, PSUs which do not provide PMBus support), 
power values may still be displayed in the iDRAC7 web and LCD interfaces. Due to lack of PMBus support in the 
PSUs, the power values displayed on the GUI pages, including the Overview > Hardware > Front Panel page, are 
not correct. 

• Due to the independent nature of the alert processes (e-mail, SMTP, remote syslog), when changing the licenses 
that affect alert features (example, email alerts for Express or remote syslog for Enterprise) there is no guarantee  
of the timing of the features being activated or deactivated when the license changes. 

• In the iDRAC Web interface, when the System Inventory page is accessed for the first time, it takes up to two 
minutes for the inventory data to be collected. After the data collection is complete, refresh the page to display 
the inventory data. 

• For the unique auto-generated certificates to work, you must make sure to synchronize the iDRAC time with the 
management station’s time to avoid certificate related issues. If the time is not synchronized, issues such as  
server certificate expiration may be seen. If this issue occurs, re-synchronize iDRAC time with the management 
station’s time and reboot iDRAC. 

• On a Linux system, if you click on a menu item and it remains open, the Ctrl + Alt + L keystroke sent from iDRAC to 
the host system does not lock the host system. The behavior is the same as using a local keyboard. 

• The default time zone value is US Central Time. To make sure Single Sign-On (SSO) and Directory Service TFA 
(smart card) continue to work properly, the iDRAC time zone must match the time zone where iDRAC is located, 
assuming Active Directory server's time zone is already configured to match the Active Directory's location. For 
example, if Active Directory server is located at US Eastern time zone and iDRAC is located at US Pacific time zone, 
Active Directory server has to be configured as US Eastern time zone (this is Active Directory server configuration 
and is normally configured), and iDRAC must be configured as US Pacific time zone. For more information to 
configure the time zone, see the iDRAC7 User's Guide. 

• If the management station is using MAC operating system, it takes more time to launch the Virtual Console due to 
the following DNS search issue:  http://www.eigenspace.org/2011/07/fixing-osx-lion-dns-search-domains/ 

• From iDRAC7 1.30.30 onwards, if you configure iDRAC using XML Import, the "user password is changed" messages 
are seen in the Life Cycle log. An entry is seen for all local user index that are not configured in XML file and have 
default values. 

• The help page for the backup and restore feature does not provide the correct share name. See the Web Services 
Interface Guide available at support.dell.com/manuals for the correct share name. 

iDRAC7 - Limitations 
• If floppy emulation is enabled when a bootable USB key is mounted as a Virtual Media from the Virtual Console and 

if you try to delete any file from the mounted USB key (floppy), the blue screen appears immediately. 

• Web server session time-out is not exact. It is either 10% more or 15 seconds more, whichever is greater. 

• WinRM and RACADM commands may become unresponsive during BIOS update or when setting BIOS, NIC, or RAID 
attributes through Lifecycle Controller. 

• Using WS-MAN and running up to 256 jobs through the job scheduler may lead to reduced iDRAC7 performance. 

• If invalid credentials are used for the maximum login attempts, the IP is blocked for the duration of the IP Blocking 
Penalty Time and a message is not displayed. 

• If Internet Explorer (IE) 64-bit browser is used to log in to iDRAC7 Web interface and when viewing the power 
usage graph, the X and Y axis labels appear too small to read. This is a known limitation for IE 64-bit only. The 
labels appear correctly in IE 32-bit browser. 



 

• On Linux management stations, if Firefox is launched from the root user, a USB key is mapped in Virtual Media 
successfully. If Firefox is launched from any user other than the root user, a USB key is not shown for mapping 
because the user must have root privileges to access all the low-level drives. 

• Alert notification for battery events does not work. 

• Operating system information on the System Summary page does not display after rebooting iDRAC7 until the 
operating system is rebooted. 

• iDRAC7 users with user names containing a semi-colon (;) cannot log in to iDRAC7 through SSH. 

• In the iDRAC7 Web interface, the power consumption sensor reading may have a rounding error of up to 13 Watts 
depending on the actual power reading. This is an IPMI limitation. The power cap, power graphs, cumulative 
power, and peak power are not affected by this inaccuracy. However, the power values shown in the power graphs 
are average values over a period of time and should not be used to calculate instantaneous power. 

• In the iDRAC7 Web interface, the power consumption sensor reading may have a rounding error of up to 13 Watts 
depending on the actual power reading. This is an IPMI limitation. The power cap, power graphs, cumulative 
power, and peak power are not affected by this inaccuracy. However, the power values shown in the power graphs 
are average values over a period of time and should not be used to calculate instantaneous power. 

• In the iDRAC7 Web interface, while viewing the CPU details under Overview > Hardware, the CPU status is 
displayed with a warning icon for a CPU that is absent and the status is blank. 

• Virtual Console uses self-signed certificates. Due to this, when launching Virtual Console from some management 
stations with Windows operating systems, a certificate warning appears. 

• Virtual Console in dual monitor mode is not supported and hence the behavior is undefined, especially using Java 
plug-in. The primary console is used as the target console. 

• The e-mail address specified in iDRAC7 Web interface -> Overview -> iDRAC Settings -> Network -> SSL -> 
Generate Certificate Signing Request (CSR) page is not validated. 

• On a Linux management station with Matrox drivers, from the Virtual Console Viewer if you access the iDRAC Chat 
window, the mouse appears flickering inside the chat window.   

• Work notes can display up to 255 characters. If any of the characters are special characters or non-alpha numeric 
characters, then the total number of characters displayed is less than 255 to accommodate overriding special 
characters. 

 
  



iDRAC7 - Open Issues and Resolutions 
Fixed Issues/def  

Issue 1 

Description 

In Chinese locale on Windows operating system, while launching the Virtual Console using Java plug-in, occasionally you may 
see a Java compilation error.  

Resolution 
1. Open the Java control panel. 
2. Go to General > Network Settings. 
3. Select Direct Connection and click OK. 

Versions Affected 

All iDRAC7 supported Dell PowerEdge systems.  

Issue 2 

Description 

Known iDRAC7 IPv6 limitations: 

• Email alerts are not sent if the iDRAC7 DNS Domain Name is not specified when using IPv6. 

• Network File Share (NFS) mounting does not work with IPv6. This applies to features such as connecting a remote 
file share or exporting the Lifecycle Controller log to a network shared location. 

• Firefox versions 4.x, 6.x, and 7.x may prevent the iDRAC7 Web interface from opening when using IPv6. For more 
information see: https://bugzilla.mozilla.org/show_bug.cgi?id=633001 

• On Microsoft Windows Operating Systems, when launching Virtual Console using Java plug-in or when launching 
Video Capture plug-in, empty warning dialogs may appear. Continue to click OK to launch the plug-in. This is a 
known limitation in Java Web Start if its Network Settings is set to use browser settings. To resolve this, set the 
Java's Network Settings to Direct Connection. 

Resolution (only for logging in to iDRAC7 Web interface): 

1. Register iDRAC7 to DNS. 

2. Make sure the client system also has this DNS in its DNS list. 

3. Enable IPv6 and disable IPv4. 

4. Log in to iDRAC7 using the Fully Qualified Domain Name (FQDN). 

For launching Virtual Console with IPv6 in Firefox 4.0 or later versions, from Windows management system, run ipconfig 
/flushdns in the command prompt. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

https://bugzilla.mozilla.org/show_bug.cgi?id=633001


 

Issue 3 

Description 

The Learn More pop-up on the License page does not appear using IE. 

Resolution 

Add *.dell.com to the trusted sites in the Security settings. See the Internet Explorer help documentation for more 
information. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

Issue 4 

Description 

On Windows operating system, to add a folder as an image using the Virtual Media, the Desktop directory must be in the 
HOMEPATH directory. The HOMEPATH directory may vary depending on the Windows installation, but the images created 
from the Add Folder as Image operation always reside in the %HOMEDRIVE%\%HOMEPATH%\Desktop directory. The   
HOMEDRIVE must be set to C drive. Otherwise, the operation fails. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

Issue 5 

Description 

If you are using Linux management station, you may have problems moving or resizing the Virtual Console when Pass all 
keystrokes to server is enabled. This is a limitation of X-Windows. 

Resolution 

Either disable Pass all keystrokes to server if the problem occurs or click in the workspace outside the Virtual Console 
window so that the console loses focus. Now, reposition and resize the Virtual Console. The keystroke option is restored if it 
was in use and temporarily disabled. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

Issue 6 

Description 

vFlash functionality remains enabled after unpreserved firmware update.  

If vFlash functionality is enabled and a firmware update is performed without preserving the configuration (preserve 
configuration unchecked), the vFlash enabled option remains selected. This is a known behavior. 

 



Resolution 

You must manually enable or disable the vFlash functionality after the firmware update as required. To do this, select or 
clear the vFlash Enabled option in the iDRAC7 Web interface, or use RACADM or WinRM remote service commands. 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge(TM) systems. 

Issue 7 

Description 

In some scenarios, typically for state change events occurring within a span of few seconds, the sequence of events 
reported in the Lifecycle Log (or corresponding SNMP traps/email alerts) for storage devices may not exactly match the 
sequence in which they occurred. 

Resolution 

The current state or attribute of the storage device can be checked in any of the iDRAC7 interfaces (example, iDRAC7 Web 
interface, RACADM and so on). 

Versions/Systems Affected  

All Dell PowerEdge(TM) systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 8 

Description 

When enclosures connected in the redundant path are re-wired (connections are switched) to result in a non-redundant 
path, the reported connected port value of the enclosures may not be accurate. 

Resolution 

Power cycle the server. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 9 

Description 

When a storage enclosure is disconnected or accidentally removed, the corresponding status of its components (that is, EMM, 
PSU, fan, and temperature sensors) are reported as critical. 

Resolution 

If the storage enclosure is disconnected accidentally, reconnect it to get back to normal state. If it is intentional, perform 
DRAC7 reboot or server power cycle to remove the enclosure entries from the consoles. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.  



 

Issue 10 

Description 
Logging in to iDRAC7 Web interface fails with the error message 'RAC0218: The maximum number of user sessions is reached'. 
When the temporary folder used by iDRAC7 components is full, it is possible that authentication fails and this error is 
displayed. 

Resolution 
Power cycle iDRAC7 to clear the temporary space. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 11 

Description 

On Microsoft Windows7 operating system, while launching Virtual Console in native mode using Internet Explorer, the 
iDRAC7 Login page is displayed. 

Virtual Console uses plug-ins and due to insufficient privileges plug-in does not load and iDRAC7 Login page is displayed. 

Resolution 
Reboot operating system and log in to iDRAC7 Web interface. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 12 

Description 

When selecting browser buttons (forward or back), the GUI pages are not displayed correctly and sometimes the same page 
re-appears.  

iDRAC7 Web interface is a platform management application and all the necessary controls are provided within the 
application. The Web browser buttons are outside of this application and may not function properly. 

Resolution 

Use the navigation options within the iDRAC7 Web interface. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 
 
 
 
 
 
 

 



Issue 13 

Description 

When you log in to iDRAC7 Web interface using Internet Explorer 9.x, contents in few pages are not shown properly. This is 
a known issue with Internet Explorer. 

Resolution 
1. Press F12. The Internet Explorer 9 Debug window is displayed. 

2. Select Document Mode > Internet Explorer 7. The browser refreshes and the iDRAC7 Login page is displayed. 

3. Close the Internet Explorer 9 debug window. 

4. Close all open Internet Explorer windows. 

5. Open Internet Explorer and log in to iDRAC7. 

For more information, see Internet Explorer documentation. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 14 

Description 

When Enterprise or Enterprise Evaluation license expires, Active Directory is disabled automatically. 

Resolution 

After re-installing the Enterprise or Enterprise Evaluation license, administrative user can log in as an existing local iDRAC7 
user to re-enable Active Directory authentication, through available interfaces such as RACADM or iDRAC7 Web interface. 
Remote RACADM can be used in script to batch-enable Active Directory. If a local iDRAC7 user is not enabled or not 
configured for direct remote access, the administrative user must use local RACADM or OpenManage Server Administrator to 
configure a local user. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 15 

Description 

When a power reset is performed, the Virtual Console Viewer menu options (except File > Exit and Help options) are 
grayed-out or inaccessible. The 'Link interrupted' message appears at the bottom of Virtual Console Viewer. 

Resolution 
Due to a temporary network outage, the Virtual Console Viewer menu options are not accessible. The ‘Link interrupted’ 
message is displayed to indicate that an outage has occurred. This is a temporary problem and the menu options are 
available when the network is restored. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 
 



 

Issue 16 

Description 

iDRAC7 Web interface does not respond when using Internet Explorer 

Resolution 
Close all Internet Explorer sessions and open it again to access iDRAC7 Web interface. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 17 

Description 
When a driver pack DUP update is performed, the following message is recorded in the Lifecycle log after the driver pack 
update entry. 
    RAC0400: iDRAC memory low   
    iDRAC is running low on memory. System performance may be degraded. 
Recommended Action: No response action is required. 

Resolution 

No workaround is required. This is a normal condition when the memory is lower than the threshold for around 30 seconds 
and returns to normal after the drive pack update. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 18 

Description 

Resetting iDRAC7 to default values action may take between four to six minutes to complete. 

Resolution 
Wait for iDRAC7 to reboot before performing any other action. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

  



Issue 19 

Description 
While deploying Windows 2008 R2 SP1 from Lifecycle Controller GUI > OS Deployment, installation terminates with the 
following error: 
    There is no disk in the drive. Please insert a disk into drive \Device\Harddisk0\DR0. 
  This issue may occur due to any of the following reasons 

• Virtual Media is in the attached state with no media mapped. 
• Virtual Media is in the auto attached state with media mapped.   
• Virtual Media being presented by the AVCT SIP and Virtual Media from iDRAC7 in the detached state.   
• The underlying cause may be due to failure to load drivers for RAID controllers on the system. 

 
  NOTE: It does not happen with Virtual Media in the detached state. It also does not happen without the SIP and with 
Virtual Media in the detached state from iDRAC7. 

Resolution 
Retry the operation. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 20 

Description 

In the iDRAC7 Web interface > Overview > Server > Power/Thermal > Power Monitoring tab > Power section, the Power 
Unit selector only changes the unit of measure. Due to the oscillating nature of power, the present reading cannot be 
displayed as units for Current (Amps). 

Resolution 
None. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 21 

Description 
On all Intel NICs, each port cannot be assigned different iSCSI initiator name (by assigning the value for IscsiInitiatorName). 
If the name is changed for one port, the same change is applied to all ports. 

Resolution 
None. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

  



 

Issue 22 

Description 

When virtual world wide name and virtual world wide port name attributes on a NIC partition are set using the WS-MAN 
interface, the new values are not updated in the iDRAC7 Web interface or when racadm getsysinfo is run. 

Resolution 
Use WS-MAN interface to obtain the updated values for those attributes. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7. 

Issue 23 

Description 
The Predicted Capacity Status attribute of the storage controller battery reported by iDRAC7 interfaces (example, iDRAC7 
Web interface, RACADM and so on) is deprecated and will be removed in a future release. It may not report the accurate 
value under some scenarios. 

Resolution 
To view the correct battery state, use the storage battery state/status values instead. 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 24 

Description 
When inventory changes are done to the storage sub-system (such as inserting and removing disk drives, and so on) before 
or during POST/reboot, the corresponding events may not be recorded in Lifecycle log. SNMP traps/email alerts may not be  
generated and the inventory changes may not be correctly reflected in the iDRAC7 interfaces (example, iDRAC7 Web 
interface, RACADM and so on). 

Resolution 
To view the correct storage inventory data, perform a server power cycle (cold boot). 

Versions/Systems Affected  
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 25 

Description 
If a NIC card, with partitioning enabled, is replaced with a similar type of card, without partitioning enabled, the 
configurations from the previous card are not applied to the new card. 

Resolution 
After the previous card is replaced with a new card and the system is powered on, go to Option ROM (CTRL-R) and enable 
partitioning. Save, exit, and reboot the system. 
 



Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

Issue 26 

Description 
When using DownloadServerPublicKey or DownloadClientCerts commands in WSMAN, the invocation may fail when the 
iDRAC7 system is not ready to service these operations. This may happen when host system is in a POST stage. 

Resolution 

Retry the command later or wait until host system past POST stage and retry the same command again. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

Issue 27 

Description 

When launching Virtual Console viewer using ActiveX plug-in, sometimes a blank window appears and Virtual Console viewer 
may not launch. 

Resolution 
This may be due to incompatible binaries from previous version. Remove temporary files from download location on your 
system and retry.  
For example, C:\windows\Downloaded Program Files. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

Issue 28 

Description 

When video player is launched, it launches both playback control window and playback window.  On Linux RHEL6.0 work 
station, if playback window losses focus then you cannot switch back using the mouse. It is not an issue on Microsoft 
Windows workstations. 

Resolution 
This is an issue with the RHEL 6.0 version of Linux.  Close the playback control window by selecting 'x' and select playback 
program on task bar using using the mouse to display the playback window. If you need to view  
  the playback controls again, select menu item from playback window. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

 

 



 

Issue 29 

Description 

If the management station is using Linux operating system with the “Pass all keystrokes to server” option enabled, you 
cannot resize the Virtual Console viewer window by dragging the corners or frame.  

Resolution: 

Do any of the following: 

• Disable the “Pass all keystrokes to server” option. 

• With “Pass all keystrokes to server’ option enabled, open any menu in the Virtual Console viewer window title bar, 
then re-size the window. 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge systems. 

Issue 30 

Description 

When running the Virtual Media client on Windows 7 or Windows Server 2008 R2, the Virtual Media client may not be able to 
access a floppy disk in read-write mode because of a problem with the client workstation operating system. 

Resolution 

Apply the operating system update to the Windows 7 or Windows Server 2008 R2 client workstation operating system as 
specified in the following link:  

http://support.microsoft.com/kb/2496290 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge systems running on Windows 7 or Windows Server 2008 R2 client workstation without 
the specified update applied. 

Issue 31 

Description 

There is no option to eject the USB drive on SUSE Linux Enterprise Server 11. The only option to unmap virtual USB is to 
force unmapping using the Virtual Media window.  

Resolution 

Unmount virtual USB before forced unmapping to make sure the server has completed all the pending tasks before the drive 
is unmapped. 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge systems. 



Issue 32 

Description 

"Learn More" option in Licensing page does not work on Safari browser. 

Resolution 

Disable the popup blocker for Safari browser. 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge systems. 

Issue 33 

Description 

Launching Virtual console using Google Chrome browser, does not launch Java Web Start automatically even after you map 
launch application. This is a known issue with Google Chrome browsers. 

Resolution 

Map launch application to Java Web Start every time. To do this, right-click on the downloaded file, click open and map it 
to Java Web Start.  

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge systems. 

Issue 34 

Description 

In a Linux operating system, after logging in to the iDRAC Web interface using a Firefox browser and you launch the Virtual 
Console, sometimes Virtual Console window does not respond to keyboard input. 

Resolution 

Close and re-launch the Virtual Console. 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge systems. 

Issue 35 

Description 

When there is no license installed on a value line platform like T420, you cannot perform any firmware update through 
iDRAC Web interface using Dell Update Packages (DUPs). This is the correct behavior, but the displayed error message is not 
correct. Error message is  "LIC006: The License has expired. Obtain a replacement license and import it.”  

 



 

Resolution 

Obtain an appropriate license then try again. If the problem persists, contact technical support. See the product 
documentation to choose the contact method that is convenient for you. 

Versions/Systems Affected: 

All Dell PowerEdge systems with iDRAC7. 

Issue 36 

Description 

If you try to upload any other certificate other than a valid PKCS#12 format file, the iDRAC Web interface displays an 
incorrect error message. 

Resolution 

Upload a valid PKCS#12 format certificate file. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

Issue 37 

Description 

When you delete the custom SSL certificate when no certificate (Custom Signing certificate) is available, the Web interface 
displays a generic message – “RAC0507 Unable to find the requested resource. Do one of the following and retry the 
operation 1) Turn on the system. 2) Make the resource available.” RACADM displays a specific message – “Error RAC1026 A 
custom signing certificate does not exist.” The Web interface must display specific message similar to RACADM. 

Resolution 

No impact as such, request to delete non-existing CSC results in this message. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

  



LC2-RS – Notes 
• Auto Discovery messages are now recorded in the Lifecycle Log. 

• Driver Pack updates no longer require a reboot. 

• The ‘Automated Task Engine’ screen now displays scheduled jobs with a ‘Running’ status unlike previous versions. 

• Empty partitions are created quickly when other partitions are not in use. If other partitions are in use, then 
creating an empty partition takes longer. For example, attach partition, format partition, and so on. 

• Lifecycle Controller job scheduling is enhanced. Jobs scheduled in the same group are executed in a sequence. 
Jobs that are not in the same group and scheduled at the same time execute at the scheduled time in parallel. 

• Passwords included in URI strings must use the correct percent-encoding format. 

• The string value for Challenge-Handshake Authentication Protocol (CHAP) passwords must have either zero or 
between 12 to 16 characters. 

• Changing the system password and locking the password cannot be done in a single Lifecycle Controller job. Run a 
job to change the password, reboot the host, and then run another job to lock the password. 

• System Characterization must be enabled to correctly run the firmware update during system power on after a 
Power Supply Unit (PSU) replacement. If System Characterization is not enabled, the firmware update runs after 
the next host reboot. 

• If the system is shut down or left in the shutdown state while a job is in progress, the job cannot progress further. 
Delete the job and run it again. 

LC2-RS - Limitations 
• Lifecycle Controller-Remote Services does not support the BootP enumeration option for LegacyBootProto 

attribute. If BootP option is displayed and selected from System Setup -> Device Settings -> Select target NIC -> 
Main Configuration -> MBA Configuration -> Legacy Boot Protocol menu (press <F2> during startup to access System 
Setup), Lifecycle Controller-Remote Services does not read the value and goes into error state. To recover from 
this error state, go to Legacy Boot Protocol menu and revert to the supported options. 

• If the Intel NIC card has multiple ports with LegacyBootProto attribute, the LegacyBootProto attribute value can 
be changed to ISCSIPrimary for only one port. 

 
LC2-RS - Open Issues and Resolutions 
Issue 1 

Description 

When the status of the DUP update is checked using the WS-MAN query for the job InstanceID of the DCIM_LifecycleJob, the 
'Percentage Complete' parameter value displays 'NA' even though the job is in-progress or complete. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 



 

Issue 2 

Description 

After running a BIOS or NIC job, if you pause (by pressing Pause key on keyboard) during POST and run another BIOS or NIC 
job, it fails. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

Issue 3 

Description 

While performing platform update using the NFS share option, if the NFS service is stopped or network connection to the 
NFS share is lost while the job is in a downloading state, the job does not fail and continues to stay in a downloading state. 

Resolution 
To change the job status to: 

• Downloaded successfully - Restart the NFS service or re-establish the network connection. 
• Failed - Reset iDRAC7. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

Issue 4 

Description 

When two PSUs of same wattage and make are replaced and Part Replacement (Allow Version Upgrade only or Match 
firmware of replacement part option) feature is enabled, during platform update, the following behavior is observed: 

After the first PSU firmware update is complete, the Lifecycle log shows that both the PSUs are updated even though the 
firmware update for the second PSU is in progress. After the second PSU firmware update is complete, the Lifecycle log is 
not updated again. 

Resolution 

Query the job status using the job ID for the second PSU to get the correct status. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

Issue 5 

Description 

LC-Remote Services jobs may fail occasionally to perform the required operations (either due to manual intervention or 
system failure) and the user cannot create a new job on the same component. 

 



Resolution 

Delete all the jobs. 

Versions/Systems Affected 

All LC2-RS supported Dell PowerEdge systems. 

Issue 6 

Description 

During POST, the message ‘Lifecycle Controller update required’ appears at the top right of the screen. This indicates 
that Lifecycle Controller is in recovery mode. This issue may occur due to Lifecycle Controller corruption or if an earlier 
model of Avocent SIP is used. 

Resolution 

To bring Lifecycle Controller out of recovery mode: 

1. During POST, press F2 go to System Setup > iDRAC Settings. 

2. Under iDRAC settings, go to Lifecycle Controller and set Lifecycle Controller to Enabled. 

3. Click Back, click Finish, and then click Yes. 

If Lifecycle Controller continues to be in recovery mode, perform a remote Lifecycle Controller update using WSMAN. 

 
 
 
Global Support 
 
For information on technical support, visit www.dell.com/contactus. 
 
For information on documentation support, visit dell.com/support/manuals. Select Choose from a list of all Dell products 
and click Continue. Click Software, Monitors, Electronics & Peripherals ->Software. Click the required category to access 
the documents based on the product and the version number. 
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